The “RBT” Taxonomy Academy

A Handbook for Developing Standards-based Curriculum and Instruction

Globally Competitive... Grand Challenge - READY!

11 Secure Cyberspace
12 Enhance Virtual Reality
13 Advance Personalized Learning
14 Engineer the Tools for Scientific Discovery

Based on the work of Dr. Lorin W. Anderson
March, 2005

Revised Bloom’s Taxonomy (RBT):
“A Taxonomy for Learning, Teaching and Assessing”
Today’s Objectives:
By the end of today’s session, participants will be able to:

- Analyze the two-dimensional structure of the Revised Bloom’s Taxonomy used to develop the NC Science Essential Standards and relate how the new taxonomy and standards empower teachers to design and deliver instruction that result in high levels of learning for large numbers of students.
- Describe the formative assessment process and explain how to select or design assessment instruments and procedures that provide accurate information about how well students are learning and how teachers.
- Demonstrate a deep specific understanding of the NC Science Essential Standards through thoughtful curriculum planning including the development of formative and summative assessment plans, and the design of instruction matched to the standards and research-based best practices.
A Fundamental Truth by Dr. Lorin Anderson:

We don’t see the world as it is; we see the world through the lens through which we look at it.
4 POINTS FOR GROWTH:
DuFour’s Critical Corollary Questions
IF WE BELIEVE ALL KIDS CAN LEARN…

1. What is it we expect them to learn?

2. How will we know when they have learned it?

3. How will we respond when they don’t learn?

4. How will we respond when they already know it?
Four Fundamental Questions for Effective Curriculum Development

1. **THE LEARNING QUESTION:**

   What is important for students to learn in the limited school and classroom time available?

2. **THE INSTRUCTION QUESTION:**

   How does one plan and deliver instruction that will result in high levels of learning for large numbers of students?

3. **THE ASSESSMENT QUESTION**

   How does one select or design assessment instruments and procedures that provide accurate information about how well students are learning?

4. **THE ALIGNMENT QUESTION:**

   How does one ensure that objectives, instruction and assessment are consistent with one another?
Importance of Alignment

Alignment is an even stronger predictor of student achievement on standardized tests than are socioeconomic status, gender, race, and teacher effect.

Learning occurs best when there is:

- A purposeful process that aligns:
  - Standards
  - Instruction
  - Assessment

- Complete alignment:
  - Cognitive Type
  - Content
  - Context
Content Alignment

“Does the teacher teach and test the content written in the standards?”
Content Alignment

“Vocabulary Drill”
Each of you will receive 10 words and an assignment to engage you with your terms. Your assignment has been differentiated to meet your individual needs. Please work alone and pay close attention to your directions. You will have 5 minutes to explore your terms.
Lets Take a Test!

Please work independently.
How Did You Do?

Why Were Some More Successful Than Others?
Cognitive Type Alignment

“Do the students get to work and think at the level the standards prescribe?”
"Are the parameters of the assessment reasonably similar to the parameters of the instruction?"
How well could you learn to bake cakes from “The Cake Boss”? 
Are you ready for the test?
How well do you expect to do?

You have practiced all week!

“Betty”
How well would you do?
Overview of Revised Bloom’s Taxonomy:

Focus of SI 2011:
NC Science Essential Standards:
The Revised Bloom’s Taxonomy (RBT)
**RBT: What We Know/What We Want to Know**

1. Label each flipchart with a title:
   - What We Know
   - What We Want to Know

2. On scratch paper, list as many items as you can under each category.

3. Combine items that might go together under “What We Know” and put the most relevant ones on the flipchart.

4. Prioritize items under “What We Want to Know” and write the top priorities on the flipchart.
(1) The Learning Question:

What is important for students to learn in the limited school and classroom time available?

NC Science Essential Standards and The Revised Bloom’s Taxonomy
Write one objective that you believe to be the most important thing that you want students to learn at that grade level.
The Common Format of Objectives

Subject               Verb               Object
S                      V                      O
Quite often, the subject is implicit or understood.

The Subject is the Learner or the Student

The student (will)

The student (should)

The student (might)

Quite often, the subject is implicit or understood.
Some Science Objectives

• The student will recognize the hierarchical structure of the classification (taxonomy) of organisms – kingdom, phylum, class, order, family, genus, and species.

• The student will explain how disease-causing fungi can affect plants.

• The student will use appropriate tools and instruments safely and accurately when conducting a controlled scientific experiment.

• The student will analyze the resulting effect of balanced and unbalanced forces on an object’s motion in terms of magnitude and direction.
Emphasizing the Verbs

• The student will **recognize** the hierarchical structure of the classification (taxonomy) of organisms – kingdom, phylum, class, order, family, genus, and species.

• The student will **explain** how disease-causing fungi can affect plants.

• The student will **use** appropriate tools and instruments safely and accurately when conducting a controlled scientific experiment.

• The student will **analyze** the resulting effect of balanced and unbalanced forces on an object’s motion in terms of magnitude and direction.
Emphasizing the Objects

• The student will recognize the hierarchical structure of the classification (taxonomy) of organisms – kingdom, phylum, class, order, family, genus, and species.

• The student will explain how disease-causing fungi can affect plants.

• The student will use appropriate tools and instruments safely and accurately when conducting a controlled scientific experiment.

• The student will analyze the resulting effect of balanced and unbalanced forces on an object’s motion in terms of magnitude and direction.
The verbs provide clues as to the cognitive processes intended by the person or persons writing the standard. The same verbs tend to be used across subject matters (e.g., recall, recognize, compare, summarize, explain, use, create).
One size does not fit all…

I. All students should develop an understanding of properties of objects and materials, position and motion of objects, light, heat, electricity, and magnetism. (Global)

A. Students will understand the properties of waves and the wavelike property of energy in earthquakes, light and sound. (Educational)

1. Students will compare the properties of waves to the wavelike property of energy in earthquakes, light and sound.

Teachers are expected to write instructional objectives based on the global and educational objectives.
<table>
<thead>
<tr>
<th><strong>SCOPE</strong></th>
<th><strong>GLOBAL</strong></th>
<th><strong>EDUCATIONAL</strong></th>
<th><strong>INSTRUCTIONAL</strong></th>
<th><strong>(INSTRUCTIONAL) Success Criteria</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>(National Standards)</td>
<td>(Essential Standards &amp; Clarifying Obj.)</td>
<td>(Learning Targets)</td>
<td>(Student Friendly Language)</td>
</tr>
<tr>
<td><strong>Time Needed to Learn</strong></td>
<td>Broad</td>
<td>Moderate</td>
<td>Narrow- derived from CO</td>
<td>Student driven</td>
</tr>
<tr>
<td></td>
<td>One or more years</td>
<td>Weeks or months</td>
<td>Hours or days</td>
<td></td>
</tr>
<tr>
<td><strong>Purpose or Function</strong></td>
<td>Provide Vision</td>
<td>Design Curriculum</td>
<td>Prepare Lesson Plans</td>
<td>Guide learning while student is engaged in learning tasks</td>
</tr>
<tr>
<td></td>
<td>Plan a multi-year curriculum</td>
<td>Plan units of instruction</td>
<td>Plan daily activities, learning experiences, and exercises</td>
<td>Provide framework within which formative assessment takes place and make possible the interpretation of evidence</td>
</tr>
</tbody>
</table>

**Relationship of Objectives**
Summary of Structural Changes from the Original Framework to the Revision: Addressing Content

<table>
<thead>
<tr>
<th>Knowledge</th>
<th>Remember</th>
</tr>
</thead>
<tbody>
<tr>
<td>Comprehension</td>
<td>Understand</td>
</tr>
<tr>
<td>Application</td>
<td>Apply</td>
</tr>
<tr>
<td>Analysis</td>
<td>Analyze</td>
</tr>
<tr>
<td>Synthesis</td>
<td>Evaluate</td>
</tr>
<tr>
<td>Evaluate</td>
<td>Create</td>
</tr>
</tbody>
</table>

Separate Knowledge Dimension

Verb Aspect

Noun Aspect
Cognitive Type Alignment:

The Cognitive Process Dimension is the alignment for Standards and Assessment

“Do the students get to work and think at the cognitive level the standards prescribe?”
Cognitive Process Dimension: 6 Categories Associated with Two or More Cognitive Processes (19 total processes)

- Remember
- Understand

- Recognizing
- Recalling
- Interpreting
- Exemplifying
- Classifying
- Summarizing
- Inferring
- Comparing
- Explaining
Cognitive Processes (continued)

• Apply
• Analyze
• Evaluate
• Create

• Executing
• Implementing
• Differentiating
• Organizing
• Attributing
• Checking
• Critiquing
• Generating
• Planning
• Producing
Content Alignment:
The Knowledge Dimension is the alignment for Standards and Instruction

“Does the teacher teach and test the content presented in the standards?”
The objects specify the CONTENT of the standard (e.g., interviewing & persuasive techniques; multiplication & division facts; states of matter; political alliances and policies). Unlike the verbs, the objects of the standards are...

subject specific
(e.g., ELA, math, science, social studies).
So, how does the revised taxonomy address content?

To design a classification system appropriate for all subject matters (and grade levels), CONTENT had to be replaced with KNOWLEDGE.

Thus, four types of knowledge were identified. The objects of the standards were referred to as NOUNS.
What are Differences Between Content and Knowledge?

• Content is subject-matter specific. If you focused on content, then, you would need as many taxonomies as there are subject matters (e.g., one for science, history, math, art, etc.)

• Content exists outside the student. A major problem, then, is how to get the content inside the student. When content gets inside the student, it becomes knowledge. This transformation of content to knowledge takes place through the cognitive processes used by the student.
HOT ARTICHOKE DIP (Serves 10 to 14)

2 14-oz cans artichoke hearts
16 oz. mayonnaise
1 c. grated Parmesan cheese
Garlic salt (optional)

1. Drain artichoke hearts.
2. Mash artichokes with fork.
3. Mix with mayonnaise, cheese, and garlic salt.
4. Bake at 350 degrees for 15 minutes or until cheese is melted.
5. Serve with crackers or party rye.
A. Factual Knowledge

Basic elements students must know to be acquainted with a discipline or solve problems in it.

Sub-types:
Aa. Knowledge of terminology
Ab. Knowledge of specific details and elements
Examples of Factual Knowledge

• 1812
• William Shakespeare
• 4 \times 3 = 12
• >
Standards on Factual Knowledge

Students will

1. identify prominent inventors and scientists of this period.
2. remember the rules for using commas, semi-colons, and colons.
3. skip-count 1-20.
B. Conceptual Knowledge

The interrelationships among the basic elements within a larger structure that enables them to work together.

Sub-types:

Ba. Knowledge of classifications and categories

Bb. Knowledge of principles and generalizations

Bc. Knowledge of theories, models, and structures
What is a concept?

A mental construct that frames a set of examples sharing common attributes. Concepts are timeless, Universal...
Conceptual Knowledge

Has to be taught by defining the attributes and with multiple examples and non-examples (some of which are near-misses); can be abstract or concrete.
Standards on Conceptual Knowledge

Students will

1. distinguish between inherited traits and those acquired from environmental factors.
2. evaluate sources for accuracy, bias, and credibility.
3. use Boyle’s law for gas pressure to solve given problems.
C. Procedural Knowledge
How to do something: methods of inquiry, and criteria for using skills, algorithms, techniques, and methods

Sub-types:

Ca. Knowledge of subject-specific skills and algorithms
Cb. Knowledge of subject-specific techniques and methods
Cc. Knowledge of criteria for determining when to use appropriate procedures
Examples of Procedural Knowledge

- In math, algorithms for performing long division
- In science, methods for designing experiments
- In ELA, procedures for spelling words
Standards on Procedural Knowledge

Students will

1. Demonstrate the steps for dribbling a basketball.

2. Carry out procedures to measure and record daily weather conditions.

3. Use order-of-operation rules appropriately to solve problems.
D. Metacognitive Knowledge

Knowledge of cognition in general as well as awareness and knowledge of one's own cognition (thinking about your thinking)

Sub-types:

Da. Strategic knowledge

Db. Knowledge about cognitive tasks, including appropriate contextual and conditional knowledge

Dc. Self-knowledge
Examples & Non-examples of Metacognitive Knowledge

Examples:

1. Knowing when to use mnemonic strategies, paraphrasing, summarizing, questioning, note-taking, or outlining to attain a learning goal.
2. Realizing that your study session will be more productive if you work in the library rather than at home.
3. Knowing that the science textbook chapters have to be studied differently from novels.

Non-examples: Standards that ask the student to
A. Outline the structure of local government. (B)
B. Identify the author’s perspective in a literary work. (B)
CLUES:
How do you know you’re dealing with Metacognitive Knowledge?

- Assessments will be subjective and divergent.
- It would not be directly assessed on a standardized test.
- Difficult to measure via paper and pencil tests—best done through classroom discussion and observation or examination of individual student work.
TASK

Looking for Meta-cognition
Question:
If the day before yesterday was Thursday, what would the day after tomorrow be?

- How did you solve the problem?
- How do you know that you are right?
- What other ways could you use to test to see if you are right?
- How did you know where to begin?
- What prompted you to start with Thursday?
- What do you do when you get lost?
ENGAGING AND SUSTAINING METACOGNITION:

1. Pose questions that cause the student to check for accuracy
2. Pause and clarify but don’t interrupt
3. Provide data, not answers
4. Resist making value judgments or agreeing with students’ answers
5. Stay focused on thinking processes
6. Encourage persistence
When you combine the verbs (cognitive processes) with the nouns (knowledge) you end up with a two-dimensional table: the Taxonomy Table.
RBT Taxonomy Table – Tagging  
(ref. pp 23 – 24)

**THE COGNITIVE PROCESS DIMENSION**

<table>
<thead>
<tr>
<th>THE KNOWLEDGE DIMENSION</th>
<th>1. REMEMBER</th>
<th>2. UNDERSTAND</th>
<th>3. APPLY</th>
<th>4. ANALYZE</th>
<th>5. EVALUATE</th>
<th>6. CREATE</th>
</tr>
</thead>
<tbody>
<tr>
<td>A. FACTUAL Knowledge</td>
<td>A1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>B. CONCEPTUAL Knowledge</td>
<td></td>
<td>B2</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>C. PROCEDURAL Knowledge</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>D. METACOGNITIVE Knowledge</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
The [Based on] Convention

THE COGNITIVE PROCESS DIMENSION

<table>
<thead>
<tr>
<th>THE KNOWLEDGE DIMENSION</th>
<th>1. REMEMBER</th>
<th>2. UNDERSTAND</th>
<th>3. APPLY</th>
<th>4. ANALYZE</th>
<th>5. EVALUATE</th>
<th>6. CREATE</th>
</tr>
</thead>
<tbody>
<tr>
<td>A. FACTUAL Knowledge</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>B. CONCEPTUAL Knowledge</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>C. PROCEDURAL Knowledge</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>D. METACOGNITIVE Knowledge</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

THE COGNITIVE PROCESS DIMENSION

1. REMEMBER
2. UNDERSTAND
3. APPLY
4. ANALYZE
5. EVALUATE
6. CREATE

THE KNOWLEDGE DIMENSION

A. FACTUAL Knowledge
B. CONCEPTUAL Knowledge
C. PROCEDURAL Knowledge
D. METACOGNITIVE Knowledge
First Science Objective

- The student will recognize the hierarchical structure of the classification (taxonomy) of organisms – kingdom, phylum, class, order, family, genus, and species.

Verb => Recognize => Remember

Object => Kingdom, Phylum, Class, Order, Family, Genus, and Species => Factual Knowledge

Objective => Remember Factual Knowledge => A1
Second Science Objective

• The student will explain how disease-causing fungi can affect plants.

Verb => Explain => Understand

Object => Fungi, Cause-Effect, Plants => Conceptual Knowledge

Objective => Understand Conceptual Knowledge => B2
Third Science Objective

The student will use appropriate tools and instruments safely and accurately when conducting a controlled scientific experiment.

Verb => Use => Apply

Object => How to Use Tools and Instruments => Procedural Knowledge

Objective => Apply Procedural Knowledge => C3
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>A. Factual Knowledge</td>
<td></td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>B. Conceptual Knowledge</td>
<td></td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>C. Procedural Knowledge</td>
<td></td>
<td></td>
<td>X</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>D. Metacognitive Knowledge</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Fourth Science Objective

• The student will analyze the resulting effect of balanced and unbalanced forces on an object’s motion in terms of magnitude and direction.

Verb => Analyze => Analyze

Object => Balanced Forces, Unbalanced Forces, Motion, Magnitude, Direction => Conceptual Knowledge

Objective => Analyze [Effect Based On] Conceptual Knowledge => B4
<table>
<thead>
<tr>
<th>THE COGNITIVE PROCESS DIMENSION</th>
<th>THE KNOWLEDGE DIMENSION</th>
</tr>
</thead>
<tbody>
<tr>
<td>6. CREATE</td>
<td>D1 D2 D3 D4 D5 D6</td>
</tr>
<tr>
<td>5. EVALUATE</td>
<td>C1 C2 C3 C4 C5 C6</td>
</tr>
<tr>
<td>4. ANALYZE</td>
<td>B1 B2 B3 B4 B5 B6</td>
</tr>
<tr>
<td>3. APPLY</td>
<td>C1 C2 C3 C4 C5 C6</td>
</tr>
<tr>
<td>2. UNDERSTAND</td>
<td>B1 B2 B3 B4 B5 B6</td>
</tr>
<tr>
<td>1. REMEMBER</td>
<td>A1 A2 A3 A4 A5 A6</td>
</tr>
</tbody>
</table>

A. FACTUAL Knowledge

B. CONCEPTUAL Knowledge

C. PROCEDURAL Knowledge

D. META-COGNITIVE Knowledge
Complete the two-dimensional chart by tagging the verbs and objects in the sample standards.
SAMPLE STANDARDS

1. The student will compare whole numbers, fractions, decimals, and percents, using concrete materials, drawings of pictures, and mathematical symbols.

2. Students will discuss the negative impacts of pesticides on the pollination process.

3. Students will explain how technological and scientific advances, including navigational advances and the use of gunpowder, affected various parts of the world politically, socially, and economically and contributed to the power of European nations.

4. The student will recognize tone, mood, and theme in works of literature and relate to personal experience.

5. The student will learn how to round whole numbers and decimals.

6. Students will use appropriate tools and technology (such as calculators, computers, probes, thermometers, balances, spring scales, binoculars, microscopes, and hand lenses) to perform tests, collect data, and display data.
7. Students will classify matter as elements, compounds, or mixtures based on how the atoms are packed together in arrangements.

8. The student will learn compare physical changes such as size, shape and state to chemical changes that are the result of a chemical reaction to include changes in temperature, color, formation of a gas or precipitate.

9. The student will identify the necessary and sufficient properties that characterize quadrilaterals.

10. Students will accept the skepticism of others as part of the scientific process.

11. Students will explain the implications of the depletion of renewable and nonrenewable energy resources and the importance of conservation.

12. The student will explain why offspring that result from sexual reproduction (fertilization and meiosis) have greater variation than offspring that result from asexual reproduction (budding and mitosis).
TASK

Write one objective that you believe to be the one most important thing that you want students to learn in your subject at that grade level.

Re-write your objective in RBT. Share with your team.
Some Conclusions

• To solve shared problems, we need shared lenses.
• Shared lenses provide a common way of thinking about problems and a common language to talk about them.
• Any shared lens (framework) is better than no lens at all. Without a shared lens, we are all in this alone.
Why the Revised Taxonomy?

• Historical link (1949 to the present)
• Two dimensions match the structure of all objectives: subject-verb-object.
• Verbs are critical since they represent the cognitive processes; objects, in noun form, represent the subject-matter content.
• Complete “crossing” of rows with columns (e.g., students can remember factual, conceptual, procedural, and metacognitive knowledge).
Refreshment Break: Parking Lot ✓